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ENGLISH

How to Replace the Turntable Stylus (Needle)
Removing the old stylus
1.	 Place a screwdriver at the tip of the stylus and push 

down in direction “A”.
2.	 Remove the stylus by pulling it forward and down.

Installing a new stylus
1.	 Hold the tip of the stylus and insert the other end by 

pressing in direction “B”.
2.	 Push up in direction “C” until it locks at the tip.

Layout
1.	 45 RPM ADAPTER
2.	 TONE ARM TRACKING INDICATOR
3.	 DECORATION  

(NOT FOR ADJUSTING THE TONEARM)
4.	 TONEARM
5.	 TONEARM REST
6.	 SPEED SELECTOR
7.	 STYLUS
8.	 NEEDLE COVER
9.	 TURNTABLE
10.	ATMOSPHERE LIGHT
11.	RCA LINE OUT CABLE
12.	USB SOCKET
13.	AC POWER CORD
14.	DUST COVER
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PART I: Phonograph
1.	 Connect the RCA line out jacks to the auxiliary input sockets of your amplifier. Make sure to match the 

socket colours with the jack colours.
2.	 Connect the AC plug to a household socket. The atmosphere light will be lit blue the whole time.

	

3.	 Place a record on the turntable. Remember to use the 45 RPM adapter located at the top right corner 
when playing a 45 RPM record.

4.	 Select the speed according to the record you are playing.
5.	 Lift and move the tonearm to the turntable, the TONEARM TRACKING INDICATOR will light up. Place 

the tonearm on the edge of the record and the record starts playing.
	 NOTE: �It is strongly recommended to close the transparent cover while playing a record to prevent dust 

from getting inside. Also, please do not place anything on top of the dust cover, especially while 
playing a record.

6.	 To pause or stop playing, you need to lift and move the tonearm back to the tonearm rest manually.
7.	 When the record reaches the end, the tonearm stops rotating. Lift the tonearm and place it on the 

tonearm rest manually.

PART II: Audacity Software
The provided CD contains the following software:
(1) 	audacity-src-1.2.6----------For source codes
(2) 	Audacity_for_MAC---------For Macintosh
(3) 	Audacity_for_WIN----------For Windows 
(4) 	AUTORUN.INF
(5) 	The GNU General Public License.html
The software is compatible with Windows® 98, 2000, ME, XP, Vista, 7 and Macintosh®.
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Audacity Installation and USB Connection 
Connect one end of USB cable to the turntable and the other end to your computer. Then plug in the 
turntable AC power cord.

Audacity for Windows®

1.	 Please insert the Audacity software disk that comes with your unit. Go to My Computer and double click 
on the CD ROM Drive.

	

2.	 There are five folders on the Audacity disk. Select Audacity_for_WIN for Windows® system and then 
select Audacity_for_MAC for Macintosh® system. 

	

3.	 Double click on the Audacity_for_WIN for Windows® system and then double click on the audacity-win-
1.2.6 to install the Audacity software. 
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Installing the Audacity Software
1.	 The Audacity Setup Wizard will appear. Click on Next to install the software. 

	

2.	 Click on “I accept the agreement” and then click on Next.
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3.	 Continue clicking on the Next buttons.
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4.	 Click on the Install button to start installation.

	

	

5.	 Click on Finish to complete installation.

	

6.	 You can now open the Audacity software and start recording your files. NOTE: Once you set up Audacity, 
you do not need to reset it with each use.

	 (For additional information, visit the Audacity website at http://audacity.sourceforge.net)

http://audacity.sourceforge.net


8

Configuring Audacity for Microsoft Windows®

Audacity Interface

Audacity Control Buttons
Use the audio control buttons at the top of the screen:Skip to Start, Play, Record, Pause, Stop and Skip to 
End. Use the File, Edit, View, Project, Generate, Effect and Analyze menus to Save, Export, and edit the 
music.
1.	 Click the ( ) button to skip to start;
2.	 Adjust the output volume;
3.	 Click the ( ) button to play;
4.	 Click the ( ) button to record;
5.	 Click the ( ) button to pause the recording; 
6.	 Click the ( ) button to stop the recording; 
7.	 Adjust the input volume;
8.	 Click the ( ) button to skip to end;
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Audacity Preferences
1.	 Click “Edit” on the Audacity interface, select “Preferences”.

	

	 •	 The screen will open up Audacity Preferences. You can see the Audio I/O, Quality, File Formats, 
Spectrograms, Directories, Interface, Keyboard and Mouse in the Audacity Preferences interface.

	

2.	 Select the recording device: microphone (USB Audio CODEC)
	 •	 Click “Audio I/O” on the Audacity Preferences interface.
	 •	 Click “Device” and select “microphone (USB Audio CODEC)”.
	 •	 Click “Channels” and select 2 (Stereo).
	 •	 Tick the checkboxes below “Channels”.
	 •	 Click “OK”.
	 Note: �If you cannot find the “microphone (USB Audio CODEC)” on the Device list, close Audacity and  

re-open to try again.
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3.	 Adjust the output and input volume.

	

	 NOTE: �Because of the variation between different operating systems, the input volume control may not 
work with some versions of Windows®. Windows® Vista is recommended to ensure the input 
volume control works properly.

For more information on setup, please see ‘Setting up Audacity’ on the website below:
http://wiki.audacityteam.org/index.php?title=Transferring_tapes_and_records_to_computer_or_CD
And for any query on the ‘Mixer Toolbar’ please see
http://wiki.audacityteam.org/index.php?title=Mixer_Toolbar_Issues

http://wiki.audacityteam.org/index.php?title=Transferring_tapes_and_records_to_computer_or_CD
http://wiki.audacityteam.org/index.php?title=Mixer_Toolbar_Issues
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Recording Operation
To download music and save to your computer:
1.	 Place the record on the turntable.
2.	 Move the tonearm over to the record to start playing.
3.	 Click the Record ( ) button to start recording.
	 The waves (left and right tracks) will show on the interface.

	

4.	 At the end of a song, click “Stop” ( ) in Audacity, then lift and move the tonearm to the tonearm rest. 
Move the cursor to the wave area and left click at the end of the song.

	 For the next song, replace the record or move tonearm to another desired song. Immediately press the 
“Record” ( ) button in Audacity and recording will continue and another set of R/L tracks will appear on 
the interface.

	

5.	 Repeat steps 3 and 4 until you have finished recording.
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General Problems for all Versions of Windows®

1.	 When the turntable is connected, you cannot hear any sound when you want to listen to video or music. 
This is because the default playback device has been changed to USB Audio CODEC after the turntable 
is connected to the PC.

	 Solution 1: 
	 Remove the USB cable from the PC.
	 Solution 2: 
	 Vista and Windows 7:
	 Click “Start” and go to the Control Panel. Find and click the “Sound” icon. Click the “Playback” tab and 

change the playback device. Click “OK”.

	

				   (Vista and Windows 7)					     (Other versions)
	 Other versions (e.g.: Windows XP):
	 •	 You can click “Start” and find “Programs”, “Accessories”, “Entertainment. Then click “Sound 

Recorder”. When in the Sound Recorder, click the “Edit” tab and select “Audio Properties”.
	 •	 Or, find and click on “Control Panel”. Find and select “Sound and audio device” and choose the “Audio” 

tab.
	 In Sound playback, change the default device by clicking on the drop-down arrow. Select your playback 

device and click “OK”.
	Sound is emitted. 
	 !	 Please note that you need to change the settings manually every time you connect the USB cable to 

the PC.
	 For more information on resetting the Windows® system sound, please go to 
	 http://wiki.audacityteam.org/index.php?title=USB_turntables#Set_up_Audacity_to_record_from_the_

turntable

http://wiki.audacityteam.org/index.php?title=USB_turntables#Set_up_Audacity_to_record_from_the_turntable
http://wiki.audacityteam.org/index.php?title=USB_turntables#Set_up_Audacity_to_record_from_the_turntable
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2.	 If you want to hear the music while recording, follow the steps below:
	 Go to the Audacity interface. 
	 Click Edit and select “Preferences”. Then click “Audio I/O” tab
	 and select  the following setting. Click “OK” to confirm.
	 Deselect the checkbox to disable its function.

	

	 For more information please see ‘Set up Audacity to record from the turntable’ at the website below:
	 http://wiki.audacityteam.org/index.php?title=USB_turntables#Set_up_Audacity_to_record_from_the_

turntable

http://wiki.audacityteam.org/index.php?title=USB_turntables#Set_up_Audacity_to_record_from_the_turntable
http://wiki.audacityteam.org/index.php?title=USB_turntables#Set_up_Audacity_to_record_from_the_turntable
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Adjustment for Windows® 7 and Vista only
If you do not have the fluctuant wave on the Audacity interface or the sound is distorted when recording, 
adjust the recording level as described below:
	 •	 Click “Start” in the lower left corner, go to the Control Panel.

	

	 •	 In Classic View, double click the Sound icon. 
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	 •	 Or in the Control Panel Home view, click “Hardware and Sound”. Then click “Sound”.
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	 •	 In the Sound interface, select the “Recording” tab. 
	 •	 Then, choose a recording device. Here we recommend you select Microphone USB Audio CODEC 

which is highlighted in the picture and click “Properties”. 

		

	 •	 Select “Levels” and adjust the Volume Setting. The setting range is from 0 to 100. Normally it should 
be between 3 and 6. However, you may refer to the Input Level Indicator from the Audacity panel 
that does not exceed 0. Then click “OK” on the Microphone Properties interface and sound interface. 
Close the Control Panel. (Please note that there is no “Levels” tab in the “Sound” panel on certain 
operating systems, such as Windows® 98 and Windows® 2000. For Windows® 7 users and Vista 
users, the “Levels” tab is available in the “Sound” panel).

	

tj
附注
“tj”设置的“MigrationConfirmed”
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	 For more information on Windows® Vista
	 http://wiki.audacityteam.org/wiki/Windows_Vista_OS
	 For more information on Windows® 7
	 http://wiki.audacityteam.org/wiki/Windows_7_OS
	 •	 You have a music recording on your computer now but the music needs to be saved and converted 

to WAV, Ogg or MP3 format before exporting.
	 •	 You may play back the song through your computer.
	 •	 Simply click ( ) to play and turn on your computer speakers
NOTE: You can visit the Audacity website at http://audacity.source forge.net.
for more detailed information and operation instructions, etc.

Preparing to Export and Save to MP3 Format 

Prepare for MP3 Export--- (Additional software “lame_enc.dll” needs to be installed).
1.	 Please make sure that the Audacity disk is still inserted in your computer. 
2.	 Click the “Edit” tab on the Audacity interface and select “Preferences”.

	

http://wiki.audacityteam.org/wiki/Windows_Vista_OS
http://wiki.audacityteam.org/wiki/Windows_7_OS
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3.	 Select the “File Formats” tab and click on the “Find Library” button.

	

4.	 A dialogue box will appear. Click “Yes”.

	

5.	 Another box appears to locate “lame_enc.dll”. Select “Yes” and find and select the lame_enc.dll file.
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6.	 Click the “OK” Button.

	

Now the MP3 software set up is complete and you may proceed with exporting to MP3 format. 

Dividing Tracks 

1.	 Press the ( ) button to return to the beginning of the first song.
2.	 Move the cursor to the wave graphic area, left click and hold, then drag from left to right. Release the 

mouse when the highlighted area reaches the end of the first song.

	

3.	 Click the "File" tab and select "Export Selection as MP3".
4.	 The window will pop up a dialogue box for you to enter the song title (File name), where you want to save 

it (Save in), and the file format (Save as type).
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5.	 Click “Save” and the first song will be saved on your computer.
	 See the interface example below, saved in MP3 format:

	

	 Complete box below:

	

Second song to be divided and saved:
1.	 Move the cursor to the wave graphic at the beginning of the second song. Left click, hold and drag from 

left to right until you reach the end of the second song. 
2.	 Click the “File” tab then select “Export Selection as MP3”.
3.	 Follow the steps above to the divide songs, one-by-one. 

Export and Save as WAV and Ogg Formats (after recording is complete)

When the song is finished, click the ( ) buttonon Audacity. Then lift and move the tonearm to the tonearm 
rest.
1.	 Highlight the song you want to save, and then click the File tab on the Audacity interface.
2.	 Select “Export Selection as WAV” or “Export Selection as Ogg”.
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	 To Export Selection as WAV

	

	 To Export Selection as Ogg

	

3.	 Once you have chosen to which file format the recording should be exported, the interface below 
appears. Here you can enter the file name and the location where it will be saved, e.g. on the desktop. 
Then click “Save”.

	 Save as WAV
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	 Save as Ogg

	

Note: You have an option to save all the songs into one file at once, after completing the recording click the 
File tab and select Export as MP3, Export as WAV or Export as Ogg.

Copying the Music File to an MP3 Player

1.	 Connect your MP3 player to your computer via a USB cable.
2.	 Turn on your computer.
3.	 Double click “MY COMPUTER”
4.	 Locate the drive named “REMOVABLE DISK” or “MP3 PLAYER” – This is your MP3 player.
5.	 Double click the “REMOVABLE DISK/MP3 PLAYER” – This opens the folder. It will show all files 

currently on your player.
6.	 Next locate your music files on your computer. Most people store them in their “MY MUSIC” folder.
7.	 Once your music folder/MP3 file folder is open, click once to highlight the song you want to send to your 

MP3 player. One of the following steps will copy the MP3 file:
	 A.	 Right click on the highlighted song and a box will come up. Move the cursor to “SEND TO” and 

another box will come up. If you have the option “REMOVABLE DISK”, click on it. This will send a 
copy of your MP3 file to the MP3 player. 

	 B.	 If you do not have a “REMOVABLE DISK” option listed, click on “COPY”. Go back and repeat steps 3, 
4 & 5 (above). Right click the middle of the window and a box will open. Select “PASTE” and the MP3 
file will be sent to your MP3 player. 

Audacity for Mac®

1.	 Please insert the Audacity software disk that comes with your unit. Click the Audacity disk on the desktop.

	

2.	 There are five folders on the Audacity disk. Select Audacity_for_Mac for Macintosh® systems and then 
select Audacity_for_WIN for Windows® systems. 
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	 •	 If your computer is a Mac® OS X system (Intel CPU), please enter the Intel folder to install the 
Audacity software;

	 •	 If your computer is a Mac® OS 9 system, please enter the Mac® OS 9 folder to install the Audacity 
software;

	 •	 If your computer is a Mac® OS X system (Power PC CPU), please enter the PPC folder to install the 
Audacity software. 

3.	 Double click on the setup file according to your supported system, for example, the “audacity.dmg” icon. 
The software files will now open in a folder. Select all the files in the folder and drag them into a suitable 
location on the hard drive (Applications, etc.).

4.	 Double click on the Audacity icon to start the software, alternatively, drag the “orange ball wearing 
headphones” icon down onto the desktop toolbar. Click on this icon to run Audacity.

Configuring Audacity for Mac®

Audacity Interface for Mac®

Audacity Interface---Settings and controls. 
At the top of the main Audacity window, to the right of the play control buttons, you will see the input and 
output level meters (labelled L and R). Under the output level meter is an icon that looks like a microphone. 
Next to the microphone is a black arrow pointing down. Click this arrow and select Start Monitoring. (If you do 
not see the input and output level meters, open your Preferences again as described above).
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Audacity Control Buttons
Use the audio controls button at the top of the screen: Skip to Beginning, Play, Record, Pause, Stop and 
Skip to End. Use the File, Edit, View, Project, Generate, Effect and Analyze menus to Save, Export, and edit 
the music.
1.	 Click the ( ) button to skip to start;

2.	 Click the ( ) button to play;

3.	 Click the ( ) button to record;

4.	 Click the ( ) button to pause the recording; 

5.	 Click the ( ) button to stop the recording; 

6.	 Click the ( ) button to skip to the end;
7.	 Adjust the output volume.
8.	 Adjust the input volume.

Audacity Preferences
1.	 Click the “Audacity” on the Audacity interface, select “Preferences”.

	

	 •	 �The screen will open up your Audacity Preferences. You can see the Audio I/O, Quality, Import/
Export, Interface, Spectrograms, Directories, Smart Recording, Theme, Keyboard and Mouse.
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2.	 Select the recording device: Core Audio (USB Audio CODEC)
	 •	 Click “Audio I/O” in the Audacity Preferences interface.
	 •	 Click “Device” and select “Core Audio (USB Audio CODEC)”.
	 •	 Click “Channels” and select 2 (Stereo).
	 •	 Click “OK”.
	 Note: �If you can’t find the “Core Audio (USB Audio CODEC)” from the Device list, close the Audacity 

Software and re-open to try again or ensure the turntable is connected to the computer.

	

3.	 Under the Quality tab, set the Default Sample Format to 16-bit. Select OK to save your settings and 
close the Preferences window.
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To set Smart Recording
1.	 Select the Smart Recording in the Audacity Preferences interface and set the Sound Activation Level (dB) 

to -36, then click OK.

	

2.	 At the top of the main Audacity window, to the right of the input and output level meters (labelled L and 
R), you will see the input and output volume. To the left of the input and output volume there is a volume 
icon. Adjust the output and input volume to maximum.

	

	 NOTE: �Because of the variation between different operating systems, the input volume control may 
not work on some versions of Windows®. Windows® Vista is recommended to ensure the input 
volume control works properly.

	 For more information on the Mixer Toolbar, please see ‘OS X-specific issues’ at the website below:
	 http://wiki.audacityteam.org/index.php?title=Mixer_Toolbar_Issues
	 For further information from Audacity on MAC OS X, please see
	 http://wiki.audacityteam.org/wiki/Mac_Bugs

Recording Operation 

To record music to your computer:
1.	 Place the record on the turntable.
2.	 Move the tonearm over to the record to start playing.
3.	 Click the “Record”  button to start recording.
The waves (top and bottom) will appear in the interface.
4.	 At end of song, click “Pause” ( ) in Audacity, lift and move the tonearm to the tonearm rest. For the next 

song, replace the record or move the tonearm to another desired song. Immediately press “Pause” ( ) 
in audacity and recording will continue.

5.	 Repeat steps 3 and 4 until you have finished recording.
	 NOTE: Do not click “Stop” button in Audacity while continuously recording songs. Remember to click 

“Pause” between your desired songs. Press “Stop” on Audacity only when all your desired songs have 
been recorded. 

http://wiki.audacityteam.org/index.php?title=Mixer_Toolbar_Issues
http://wiki.audacityteam.org/wiki/Mac_Bugs
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6.	 After you have finished recording, you may play back the songs through your computer in Stop Mode, by 
simply clicking the ( ) button.

	

Dividing Tracks
When your recording is complete:
1.	 Press the ( ) button to return to the beginning of the first song.
2.	 Move the cursor to the wave graphic area. Left click and hold and drag from left to right. Release the 

mouse when the desired section in the time bar is highlighted.
3.	 Click the “file” tab and then select “EXPORT SELECTION”. 
4.	 A dialogue box will pop up for you to fill in the Metadata. Click the OK button after you have finished.
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5. 	 Then a window appears. Select your music file location and format, and type in your file name. Click “Save” 
and the song will be saved on your computer. 

	

Export and Save Files (after recording is complete)
	 •	 When the song is finished, click the ( ) button in Audacity. Then lift and move the tonearm to the 

tonearm rest.
	 •	 You now have a music download on your computer. 
	 •	 You may play back the song through your computer.
	 •	 Simply click the ( ) button to play.
NOTE: You can visit the Audacity website at http://audacity.source forge.net.
for more detailed information and operation instructions, etc.
1.	 Click the file tab on the Audacity interface and select “Export” to save the file.
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2.	 A window will pop up below after clicking Export. The default file format is MP3, but you can select 
another format. All you need to do is click on the arrow located to the right of MP3 Files.

	

Troubleshooting Guide

If you have any problems with the unit, please look through the items below and see if you can solve the 
problem yourself before calling your dealer.
NO SOUND: 
	 •	 If you are not getting any sound into the software application, go back to Preferences as shown 

above and make sure you have selected the USB input for the recording device. 
	 •	 Power Cycle: Close Audacity, turn off the turntable and unplug the USB Cable. Then plug in the USB 

Cable, turn on the turntable and re-open Audacity. 
	 •	 If you cannot hear any audio when you play the record, please click on the microphone drop-down 

arrow and select Monitor Input. This will enable you to hear the audio from the turntable, even if you 
have not record-enabled the Audacity application. 

		

	 •	 If you cannot see the microphone slider, please go to the Preferences menu in Audacity, click on the 
Interface tab and make sure that the Enable Mixer Toolbar and Enable Meter Toolbar options are 
checked. If they are not, please check them and then press OK. 

	 •	 Check the microphone slider to make sure that it is at full volume. Move it all the way to the right 
as shown below. If you cannot see the microphone slider, please go to the Preferences menu in 
Audacity, click on the Interface tab and make sure that the Enable Mixer Toolbar and Enable Meter 
Toolbar options are checked. If they are not, please check them and then press OK.

		

POOR SOUND Quality: 
	 •	 Check your stylus connection to make sure it is secured to the tonearm. The stylus must be 

connected to the tonearm when using the turntable. 
	 •	 Make sure that your RCA plugs are plugged into a source or not touching bare metal. If you are 

experiencing noise through the USB, you may have interference from the RCA plugs. Ensure the 
USB cable is not touching or near any other cables. 

	 •	 If you experience any unusual sounds coming from the recording, try closing all applications. Then 
restart the computer and only run Audacity while recording. 

	 •	 Make sure that you have properly installed and calibrated the turntable tonearm.
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Problem Cause Solution
TH

E 
W

H
O

LE
 U

N
IT Power does not come on 

when the unit is switched on. Unit is unplugged. Connect the unit to the AC 
power supply.

The sound is distorted. The unit is too close to a TV set 
or another similar appliance.

Turn off the TV or other 
appliance and relocate the 
unit.

Specifications
DC servo motor
Belt drive
33-1/3 rpm, 45 rpm and 78 rpm
Less than 0.25% (WTD)
More than 35 dB
Ceramic stereo cartridge
402-M208-165
160-380 mV (5 cm/sec at 1 KHz)

AC 230 V ~ 50 Hz
5 W
390 x 117 x 330 mm
2.715 kg (approx.)
Instruction Manual
Audacity Software Driver CD
USB Cable

Safety precautions: 
To reduce risk of electric shock, this product should ONLY be opened by an 
authorized technician when service is required. Disconnect the product from 
mains and other equipment if a problem should occur. Do not expose the product 
to water or moisture.

Apparatus shall not be exposed to dripping or splashing and no objects filled with liquids, such as vases, 
shall be placed on the apparatus.

Maintenance:
Clean only with a dry cloth. Do not use cleaning solvents or abrasives.

Warranty:
No guarantee or liability can be accepted for any changes and modifications of the product or damage 
caused due to incorrect use of this product.

General:
Designs and specifications are subject to change without notice. 
All logos brands and product names are trademarks or registered trademarks of their respective holders and 
are hereby recognized as such.
Keep this manual and packaging for future reference.

Attention:
This product is marked with this symbol. It means that used electrical and electronic products 
should not be mixed with general household waste. There is a separate collections system for these 
products.

RISK OF ELECTRIC SHOCK
DO NOT OPEN

CAUTION
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